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Safety Guidelines

This document contains notices which you should observe to ensure your own personal safety as well as to avoid property damage. The
notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring to property damage only
have no safety alert symbol.

Danger

indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury.

Warning

indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

Caution

used with the safety alert symbol indicates a potentially hazardous situation which, if not avoided, may result in minor or mod-
erate injury.

> B B>

Caution

used without safety alert symbol indicates a potentially hazardous situation which, if not avoided, may result in property dam-
age.

Notice

used without the safety alert symbol indicates a potential situation which, if not avoided, may result in an undesirable result or
state.

When several danger levels apply, the notices of the highest level (lower number) are always displayed. If a notice refers to personal
damages with the safety alert symbol, then another notice may be added warning of property damage.

Qualified Personnel

The device/system may only be set up and operated in conjunction with this documentation. Only qualified personnel should be allowed to
install and work on the equipment. Qualified persons are defined as persons who are authorized to commission, to earth, and to tag cir-
cuits, equipment and systems in accordance with established safety practices and standards.

Intended Use

Please note the following:

Warning

This device and its components may only be used for the applications described in the catalog or technical description, and
only in connection with devices or components from other manufacturers approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up and installed correctly, and operated and
maintained as recommended.

Trademarks

All designations marked with ® are registered trademarks of Siemens AG. Other designations in this documentation might be trademarks
which, if used by third parties for their purposes, might infringe upon the rights of the proprietors.

Copyright Siemens AG 2011 All rights reserved.

Reproduction, transmission or use of this document or its contents is not permitted without express written authority. Offenders will be
liable for damages. All rights, including rights created by patent grant or registration of a utility model or design, are reserved.

Disclaimer of Liability

We have checked the contents of this document for agreement with the hardware and software described. Since deviations cannot be
precluded entirely, we cannot guarantee full agreement. However, the data in the manual are reviewed regularly, and any necessary cor-
rections will be included in subsequent editions. Suggestions for improvement are welcomed.

Siemens AG

Industry Sector

P.O. Box 4848

90327 Nuremberg Siemens AG 2011
Germany Technical data subject to change
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1 Preface

1.1 Purpose of this Document

This document supports you when commissioning and using the software
SIPLUS CMS4000 ION SIMATIC S7 PN of the SIPLUS CMS4000 product line.

1.2 Basic Knowledge Required

In order to understand this manual, general knowledge of automation technology and soft-
ware packages SIPLUS CMS4000 X-Tools, STEP 7, S7-SCL, S7-CFC is required.

In addition, you must be familiar with network technology (UDP/IP) and with using computers
with MS Windows XP.

1.3 Validity of this Document

This document is valid for the following software:
e SIPLUS CMS4000 ION SIMATIC S7 PN, V 01.00 and V 01.01
During the following pages, this software will be referred to by the term ION SIMATIC S7 PN.

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, ASE02340413C-05
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2 Scope of Delivery

21 Scope of Delivery

What is shipped?
e CD SIPLUS CMS4000 ION SIMATIC S7 PN - Software & Documentation
o Certificate of License (ColL)

e Storage medium with License Key

2.2 Unpacking and Checking

After unpacking, please check
o the packet for completeness and

¢ all parts for transport damage.

Caution

Do not use any content / parts that show evidence of damage!

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, ASE02340413C-05
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31

3.2

SIPLUS CMS4000 X-Tools

Product Overview

What is SIPLUS CMS?

SIPLUS CMS is an industrial-suited Condition Monitoring System for technical and techno-
logical services in industrial plants. SIPLUS CMS is a modular, scalable analysis and diag-
nosis system. It is optimized for reaction less measurement of analog, binary and numerical
data. SIPLUS CMS can be integrated in existing and new industrial plants.

SIPLUS CMS can be integrated into the TIA-Architecture.
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What is ION SIMATIC S7 PN?

The ION SIMATIC S7 PN is used in order to acquire data from a SIMATIC S7 PN controller
(S7-300 or S7-400) and to transmit the recorded data via Ethernet (UDP/IP) to a superior in-
dustrial PC. After the engineering, the ION SIMATIC S7 PN is used for the transmission of
measurement data to SIPLUS CMS4000 X-Tools (during the following pages referred as
X-Tools) which is a software package that is able to visualize, analyse and store the data.

The usage of an ION SIMATIC S7 PN allows transmitting up to 712 byte of data. The data is
divided into 178 channels and each channel consists of 32 bit (DWORD), where several sig-
nals can be merged to a channel.

The ION SIMATIC S7 PN consists of a function block which must be engineered into a
SIMATIC S7 PN controller with an integrated PROFINET interface.

SIPLUS CMS4000 SIMATIC S7 PN

Operating Instructions, 09/2011, ASE02340413C-05
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3.3 Hard- and Software Requirements

Hardware
e PC with Windows XP Professional (= Service Pack 2)
o CPU with 2 1.2 GHz or multicore CPU
o working memory = 512 MByte (2 GByte recommended)

o OpenGL / DirectX enabled graphic controller (from 1024x768 pixels, 1280x1024
pixels or more recommended)

o |EEE1394, Ethernet and USB interfaces
e SIMATIC S7-400 controller with integrated Ethernet / PROFINET interface
o CPU 41x-3 PN/DP
o CPU 31x-2 PN/DP
o CPU 319-3 PN/DP

e Ethernet connecting cables

Software
e SIPLUS CMS4000 X-Tools Standard or Professional (V 03.01 SP1 or higher)
e STEP7 (using V 5.4 + SP5 or higher)

3.4 Ordering Numbers
Article Ordering Number (MLFB)
SIPLUS CMS4000 ION SIMATIC S7 PN 6AT8000-0CA00-4XA0
SIPLUS CMS4000 X-Tools Standard V 03.xx 6AT8000-0AB00-1BAO
SIPLUS CMS4000 X-Tools Professional V 03.xx 6AT8000-0AB00-2BA0

Further information is obtained from your local Siemens office and from the homepage
http://www.siemens.com/siplus-cms.

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, ASE02340413C-05
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4.2

Block Description

Function

The ION SIMATIC S7 PN is used in order to acquire data from a SIMATIC S7 PN controller
(S7-300 or S7-400) and to transmit the recorded data via Ethernet (UDP/IP) to a superior in-
dustrial PC. The ION SIMATIC S7 PN consists of a function block (FB) which must be engi-
neered into a SIMATIC S7 PN controller with an integrated PROFINET interface. The com-

munication protocol is UDP/IP.

The FB is called in a cyclic interrupt (e.g. OB35) and allows transmission of up to 712 byte of
data each cycle. The data is divided into 178 channels and each channel consists of 32 bit
(DWORD). The channels are filled with data in the S7 program. It is possible to merge sev-
eral signals into one channel (e.g. two WORD signals).

The FB is called in startup OB (OB100, OB101, OB102) for initialization. Therefore the pa-
rameter COM_RST is set to TRUE. During initialization the number of active channels is writ-
ten, the cycle time is set and some other calculations for service are done.

Afterwards a phase begins, in which the FB runs along passive in the program. Only after
announcing the X-Tools the FB is activated and it takes place data exchange with X-Tools.
Details for engineering in X-Tools you can find in the X-Tools User Manual.

When data transmission is started the signals are transmitted to X-Tools. Therefore the sig-
nals are buffered in two buffers. Each buffer can store 712 bytes. With 178 active channels
one buffer is transmission buffer and one is the buffer for the current data. The buffers are al-
ternating written and transmitted. If not all channels are active more cycles can be buffered.
With 89 active channels each buffer can buffer two measurement cycles, the transmission is
initialized after each two cycles. The communication load can be reduced.

Parameters
Parameter Declara- |Data type Description
tion

COM_RST INPUT BOOL With ,True’ on this signal a reset of the FB is
forced. During runtime it should be ,False’.
The FB remains in initializing routine as long
as COM_RST is set to ,True’.

CYCLE_T INPUT INT Cycle time of calling alert in ms.

COMMAND _ID [INPUT INT ID for command connection (0x0001 ...
OxOFFF).

DATA _ID INPUT INT ID for data connection (0x0001 ... OxOFFF).

COMMAND_P [INPUT WORD Local UDP port for command connection

ORT (0x07DO0 ... 0x1388).

DATA PORT |INPUT WORD Local UDP port for data connection (0x07D0
... 0x1388).

DEV_ID INPUT BYTE Identifier for CPU type.

CURRENT_ INPUT INT Number of channels which are transmitted

CHANNELS to X-Tools each cycle (1 ... 178).

CHANNEL INPUT ARRAYI0..1 | Array, which defines the channels which

771 OF shall be transmitted to X-Tools. A reading of
DWORD peripherals is not possible.

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, A5E02340413C-05 9
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Parameter Declara- |Data type Description
tion
UIKO..UIK7 INPUT BYTE UIK of the ION SIMATIC S7 PN. See 5.6 for
details.

SIPLUS CMS4000 SIMATIC S7 PN

Operating Instructions, 09/2011, ASE02340413C-05
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4.3

Conditions

During projecting of the ION SIMATIC S7 PN the conditions of all used components have to
be respected. The ION SIMATIC S7 PN must not be called in OB1.

The minimum cycle time of the calling OB as the number of channels which can be transmit-
ted properly in this time are specific for each project and hardly depending on SIMATIC CPU
type and network usage. The used configuration has to be checked for stability and must not
operate at the limit, because in case of errors (e.g. BUS errors) a higher CPU load can be
expected.

The ION SIMATIC S7 PN can transmit limited amount of data over the PROFINET interface.
When the capacity of the interface is insufficient data is lost, in this case proper system be-
haviour can not be guaranteed. The internal counter “Drops1” counts the number of packets
which could not be transmitted properly. It can be supervised in the Variable Table.

The system is released for usage of one ION SIMATIC S7 PN per SIMATIC CPU.

Notice

Wrong project engineering can lead to errors or stop of the CPU.

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, ASE02340413C-05 11
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5 Installation

5.1 Automation License Manager

To use ION SIMATIC S7 PN software, you require a product-specific license key (user
rights). Starting with X-Tools V 03.02, this key is installed with the Automation License Man-
ger.

The Automation License Manger is a software product from Siemens AG. It is used to man-
age the license keys (license modules) for all systems.

The Automation License Manger is located on the installation device of X-Tools starting with
V 03.02. Details about installation and handling you can take from X-Tools User Manual.

The license of ION SIMATIC S7 PN is a floating license which is valid for an unlimited
amount of time. For each started Device Profile (for each active ION SIMATIC S7 PN) a li-
cense key is required by X-Tools. The key is acquired during runtime and released when the
Device Profile is stopped. More information for license management and handling of license
key you can take from X-Tools User Manual

5.2 Installation of Library ION SIMATIC S7 PN

Insert the product-CD “ION SIMATIC S7 PN - Software & Documentation” into the drive of
your PC. Start the SIMATIC Manager and open via File > Retrieve... the dialog for de-
archiving of projects and libraries. Choose the path to your CD-drive and open the archive
file “lON SIMATIC S7 PN <current version>.zip” from the product CD. Finally choose the tar-
get directory and the storage path for the ION SIMATIC S7 PN library and confirm with OK.

Dearchivieren {3280:754)

? Die folgenden Objekte wurden dearchiviert:

Frojekte: Keine
Bibliatheker: 1OM SIMATIC 57 PM
Sollen diese jetzt geoffnet werden?

Hein |

When de-archiving is finished apply the shown dialog on “Yes” to open the library. The library
is installed properly. After successful installation, the engineering can begin.

#% ION SIMATIC S7 PN -- D:\SIPLUS CMS4S7_PN

E@ 10M SIMATIC 57 PN Objektnarme Symbolizcher Marne Erstellsprache . | Tup W..| Mame [Header]
= &1 1N SIMATIC 57PN —l— ............................................ R s"_LE[ ................ e = e P
(Bl Quellen &3 FBES TCON Al BED Funkfiorsbaustein 2. TCON SIMATIC
{28 Bausteine &3 FBE7 TUSEND Al 416 Funktionshaustein 2. TUSEND SIMATIC
&3 FBea TURCY Al 472 Funktionsbaustein 2. TURDY SIMATIC
&SHFCB L7_TOD Al 242 Funktion 1. DT_TOD SIMATIC
&3 SFC READ_CLK Al - Systemfunktion 1. READ_CLK SIMATIC
&3 SFCE RO_SINFO Al - Systemfunktion 1. RO_SINFD SIMATIC
&% 5FC20 BLEMOY Al - Systemfunktion 1. BLEMOV SIMATIC
1] | I

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, ASE02340413C-05 12
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6 Engineering in AWL

6.1 Copying the necessary SW components

Opening of the Library

If the library was not opened automatically, go to the SIMATIC Manager and choose File >
Open. In the next dialog select the tab Libraries and choose the library ION SIMATIC S7 PN.
Afterwards confirm in the dialog with the “OK” button.

Uffnen Projekt [ x|
Arwenderprojekte( Bibliotheken | Beizpielprojekte I M ultiprojekte |
Hame | Ablageptad -
@ CFC Libram C:AProgram Files\SiemenstStep ™S 7libs
@ GR&aPH? C:AProgram Files\SiemenstStep ™S 7libs
T D LUS PM

C:AProgram Files'S iemens\Step?\S?Iibs_

@ FFORV_LE C:\Prograrn Files\Siemensh Step?\S 7Pra
@ RECW C:\Prograrn Files\SiemenshStep™S 7libs
@ Fedundant 10 CGP Y40 C:\Program FileshSiemenstStep™S7libs
o 1 _vl_l

Markiert
Arwenderprojekte:

Bibliothek.en: 1

Beizpielprojekte:

Fultiprojekte: Durchzuchen. . |
Abbiechen | Hite |

4

To copy the necessary components

Copy all SW components of the ION SIMATIC S7 PN. The SW components FB65, FB67,
FB68, FC8, SFC6, SFC20 originate from the library “Standard Library” and can be copied
from this source.

25 SIPLUS — D:,SIPLUS CMS'Siplus

=- SIPLUS Objekiname Symbolizcher Mame Erstellsprache Gr.. | Tup .| Mame [Header] Unli.. | &utar Mon-Re
= SIMATICS7PN [ Systemdaten - - SDB

El CPUS7 PN Organisationsbaustein
S7-Programm i i

TUR

DT_TOD unktian .. DT_TOD

READ [ - READ_CLK

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, ASE02340413C-05 13
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6.2 Calling the Function Block — Startup OBs (OB100, OB101 and OB102)

Description

The component ION SIMATIC S7 PN must be connected in the Startup OBs, to allow a sys-
tem restart when the CPU initiates the restart.

The following table shows the available Startup OB types:

Type of Startup Corresponding OB
Hot restart OB 101
Warm restart OB 100
Cold restart OB 102

Check which Startup OBs are used by your CPU and which Startup OBs your application
needs for proper initialization in all states. Maybe you need to implement more than one
Startup OB. In the following part the implementation of OB100 is shown as example.

Function Block call

If the OB100 is not available jet you must insert it into your program. For this, right Mouse
click on the component folder and select Insert new Object > Organization Block.

Eigenschaften - Organisationsbaustein E
Aligemein - Teil 1 | Aligemein - Teil 2| Aufiute | Atribute |
Mame: IDE1 ili]

Symbolischer Mame: I

Symbolkommentar; I

Erstellzprache: AL =

Frojektpfad: I

Speicherart des Projekts |D3\S|PLUS CME4Sipluz

Code Schnittstelle
Erstellt am: 05.02.201014:57:02
Zuletzt geandert am: 08.02.2010 14:57.02 08.02.2010 145702
F.ommentar; d
I-]
fbbrechen | Hife |

Open the OB100 via a double click and add a call of FB3. The assigned instance database
can be freely selected (select any free number, in the example DB3). Afterwards confirm in
the dialog with the “Yes” button and the DB is automatically generated by the SIMATIC man-
ager.

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, ASE02340413C-05 14
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OEloa "Complete Restartc"

Fommentar:

Eommentar:

FALL FE3, DB3|

Calling FB2 in the OB100
Now you must set the parameter COM_RST with TRUE to initialize the ION SIMATIC S7 PN.

For the parameter DEV_ID you must insert the identifier for your CPU according to the fol-

lowing table:
317-2 PN/DP B#16#2
319-3 PN/DP B#16#3
414-3 PN/DP B#16#5
416-3 PN/DP B#16#5

Afterwards save and close the component.

0E1l00 : "Complete PRestart"

Kommentar -

Hommentar -

CALL "ION SIMATIC 57 PN" , DE3
COM_RET : =TRUE

CYCLE_T
COMMAND_ID
DATA_ID
COMMAND_PORT
DATA_PORT

DEV_ID :
CURRENT_CHANNELS:
CHANNEL :
UTED

UTEL

UIEZ

UIES

UIE4

UIES

UIEE

UIE?

EBf1GHfE

FEZ

Initialized parameter list of the ION SIMATIC S7 PN in the OB100

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, ASE02340413C-05
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6.3 Calling the Function Block - OB3x Cyclic Interrupts

Description

The acquisition and transmission of measurement data is done via a function call in a cyclic
interrupt (OB3x). The sample time matches the cycle time of this OB. It can be configured in
HW Config. It is recommended to use a cycle time about 100 ms, it must not be above 300
ms.

Write data into the Transmission Channel

Insert new cyclic interrupt-OB into your program, or work on an existing one in your program.
In the following example OB35 is used.

The channels which can be observed will be supplied. There exists of up to 178 channels
each having 4 bytes per channel for a total of 712 bytes. The channels up to 178 are sent
cyclically to the PC via the X-Tools once connected with the ION SIMATIC S7 PN. The cur-
rent measuring data is determined by the configuration of these up to 178 channels. For the
beginning you must fill the data block. Therefore you have two options:

a) Load the data and transfer it directly into the destination channel in the DB. The editor
produces the database addresses automatically via input of the channel numbering in
the format “DB3.CHANNEL [index].

b)  All data can be written into an array which can be set to the input CHANNEL of the FB3
during block call.

OEZE : "Cyoclic Interrupt”

Fomnmentar:

[Eommentar:

L DUE16E19801224
T DEZ. CHANNEL [0]]

0B3L : "Cyclic Interrupt"

Hommentar:

Hommentar:

L DWEleglas0lzzd
T DE3.DED 16

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, ASE02340413C-05 16
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Write data into the Transmission Channel

When the channels are filled with data you can add an additional network an project you
ION SIMATIC S7 PN as follows:

OE3E - "Cyclic Interrupt"

Eomnmentar :

Hetzwerk 1: Titel:

Eomnmentar :

L DWELEF1D201Z24
T DEZ.DED 1&

Fommentar:
CALL “ION SIMATIC 27 PN" ., DEZ FE3
COM RET :=FALSE
CYCLE_T :=§OE35_EXC_FREQ
COMMAND TID i=ZL
DATA ID I=ZE
COMMAND _PORT c=WELEEI00
DaTa PORT S=WELSHS0L
DEV_ID =Ef1EHE
CURRENT_ CHANNELZ:=1&
CHANNEL H

UIED
UIEL
TIKEZ
TIE:
TIE4
UIES
UIES
UIE?

Component call in the OB35

In the cyclic interrupt COM_RST must be set to FALSE during runtime of the block. Enter for
the parameter CYCLE_T the temporary component variable OB3x_EXC_FREQ. This setting
defines the cycle time of the interrupt OB3x.

For the communication you need to specify connection IDs and port numbers. Enter for the
parameter COMMAND _ID a connection ID for the command connection (0x0001...0xOFFF)
and for the parameter DATA _ID a connection ID for the data link (0x0001...0xOFFF). Enter
for the parameter COMMAND _PORT a UDP port for the command connection
(0x07D0...0x1388). As in the example port 2048 which can be selected freely. Enter for the
parameter DATA_PORT a UDP port for the data link (Ox07D0...0x1388). As in the example
port 2049 which can be selected freely.

Enter for the parameter DEV _ID the identifier for your SIMATIC S7 CPU according to the fol-
lowing list:

317-2 PN/DP B#16#02
319-3 PN/DP B#16#03
414-3 PN/DP B#16#05
416-3 PN/DP B#16#05

Enter for the parameter CURRENT_CHANNELS the channels to be transmitted per cycle
(1...178). Attention, also empty channels are transmitted.

For the parameter CHANNEL it is optional to enter a field which contains the measurement
data. This is valid only for 178 channels.

SIPLUS CMS4000 SIMATIC S7 PN
Operating Instructions, 09/2011, ASE02340413C-05 17
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For the last inputs you have to configure the UIK of the ION SIMATIC S7 PN. Regard the fol-
lowing chapter for details.

SIPLUS CMS4000 SIMATIC S7 PN
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6.4 UIK

Description

Each ION SIMATIC S7 PN must possess a system wide defined number, the UIK. The UIK is
used by the X-Tools for the clear identification of the ION SIMATIC S7 PN. The device name,
which is shown by default in X-Tools, consists of the device type and the UIK. Example:

ION SIMATIC S7 PN (000008-00-06010000).

Assigning the UIK
It is formed under normal conditions via 2 zero bytes and the MAC address of the hardware.

Entering the parameters UIKO and UIK1 contain a zero byte (B#16#0) in each case. Enter
from UIK2 byte wise the MAC address (must be in hexadecimal representation). In the fol-
lowing example the MAC address 08-00-06-01-00-00 is used.

OBZE "Cyolic Interrupt'
Fomment ar :
Netzwerk 1: Titel:
Hommentar :
L DWELEELDIB01EZ4
T DEZ.DED 1e
Fomment ar :
CALL “ION SIMATIC 27 PH" , DEZ FEZ
COM_REST :=FALSE
C¥CLE_T 1=#0B35_EXC_FREQ
COMMAND ID =EE
DATA II =EE
COMMAND: PORT c=WElags00
DATA PORT c=WElGES01
DEV_IL t=BELlcES
CURRENT CHANNELS:=l16
CHANNEL s=
TIRD =EBflogo
TIEL c=Bflaf0 Null Bytes
UIKZ t=BElcgs
UIE: t=BELlcg0
TIE4 :=Eflege | MAC Adresse
TIKE c=Eflefl
UIEG c=Bflaf0
TUIE7? =B 1af0

Assignment of the UIK

If multiple ION SIMATIC S7 PN are to be operated on a single hardware unit (over one IP-
address), it must be ensured that the UIK is individual. Use in addition the first two bytes
(UIKO and UIK1) as example for a sequential numbering of the blocks - must be in hexa-
decimal representation - as a defined entry for a clear UIK.

SIPLUS CMS4000 SIMATIC S7 PN
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6.5 Loading Components

When you have finished you implementation mark / highlight all blocks of your project. Then
select in the menu PLC > Download or click on the appropriate symbol to load the marked /
highlighted components into the CPU. Then the CPU must be restarted (STOP ->RUN) to
initialize the ION SIMATIC S7 PN. Now the connection to X-Tools can be initiated.

£3 SIFLUS -- D:\SIPLUS C|
SIPLUS

: Nan et
=-E SIMATICS7PN
=@ cPUSTRN
= 57-Programm

{B] Quellen
{£H Bausteine

&3] Plane

SIPLUS CMS4000 SIMATIC S7 PN
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7 Engineering in CFC
71 Modification of the ION_PN
Description

The component ION SIMATIC S7 PN cannot be directly placed in a CFC-plan. Instead a
covering block ION_PN (FB600) is placed in the CFC-plan and therefore calls the component
ION SIMATIC S7 PN internally. The SCL source of the ION_PN is delivered as a component
of the library. Thus making it possible to project-specifically adapt the interface to the
transmitted data.

Modifying the SCL File

Open the library ION SIMATIC S7 PN and select in the folder Sources the SCL-Source
ION_PN. Open the SCL source per double click.

#2 10N SIMATIC ST PN —- D:4,SIPLUS CMS'\S7_PN

=4 ION SIMATIC 57 PN i Syrnbolischer Nare
7] 10N SIMATIC 57 PN TN SCL Oudls
(B Duellen

4] | 2
Modifying the SCL Code
1. The initial parameter DUMMY may not be changed, deleted, shifted or renamed.

2. Behind the initial parameter DUMMY are the initial parameters for the values which
can be transferred. Designations and data types of the variables may be project-
specifically adapted. It is highly recommended in this case to provide the initial pa-
rameters with comments for the PCS7 attributes (e.g. to assign S7_visible = ,false’).

3. Make sure that the parameters projected behind the input variable DUMMY occupy a
storage area at least by CURRENT_CHANNELS x 4 byte per channel.
CURRENT_CHANNELS can be changed for the instance. Since the max. number of
channels amounts to 178, the initial parameters should occupy 712 byte.

The remaining SCL code should not be changed!
Translate the Block

Translate the component in the SCL editor over file = translating.

Notice
If it is not possible to translate the CFC block check whether FB60O is listed in symbols as “ION_PN*.

Notice

If the FB600 should be already present, before translating the existing FB600 must be deleted from the library
ION SIMATIC S7 PN and the symbolic name ION_PN must be assigned to a free module number. Secure the
changed SCL source ION_PN from ION SIMATIC S7 PN for later adjustments.
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EfSCL - [ION_PN —- SIPLUS!SIMATIC 57 PN\CPU 57 PN]
Datei Bearbeiten Einflgen Zielsystem Test Ansicht Extras Fenster Hilfe _|5’|5|

Diz(@| 8| o] sl elesldnlds| | 1] ¢ [BS(m| A2
=] @ |76 #5[e>]12 [ [bm |

%% %

féDescription of function block: -
FfThia function block converts the input parsmeter CHAMNELZ of the hlock "ICHN SIMATIC 37 FI
Jihefore the khlock "ION SIMATIC 37 PMN" is called. This makes it possikble to call use the b

S 4 The datatypes of the channels that are transferred to IIPLUI CHMI (input parsmeters hehin
ffchange the other code of the function block.

i

S WARNING:

/¢ Thizs blocks copies CURRENT CHAMMELZ*4 bytes from the varishle DUMMY to an internal array
FfTou must take care that there are enough data defined.

FUHCTION BLOCE "ICN PH™

{87_tasklist := 'OB100'}

TITLE = 'PC3 7 hlock FOR ICN 3IMATIC 37 FN!
NAME : ICN_FN

VERSION : '1.0'

FIJOW_HOW PROTECT

VAR INFUT
DUMNY {57 _wisikle:= 'false'} : DWORD ; J/ Doy wariable: The input wariables for the cha
TEMF : REAL ; // example temperature

PRE3ZSUREL1 : RELL ; /f exsmple pressure 1
PRESSUREZ : RELL /7 ewawple pressure 2

NUMEER1 : INT : £ example nurber 1
NUMEBEERZ : INT : £ example nurber 2
CHNT : DWORD : Jf example counter

DWORDE = DWORD ;
DWORDY ¢ DWORD

-
rTeTTL, L ToTTeTT. I

1| 3
Dricken Sie F1, um HilFe zu erhalten, | |Ze 4 5Sp 67 Einfg |&nd 5

SCL source of the covering block
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7.2 Projecting of the covering component in the CFC

Project the adapted component ION_PN in the CFC-Plan and insert the ION_PN in a cyclic
interrupt (OB3x). The installation of the component into the OB100 takes place automatically;
likewise the supply of the entrance SAMPLE_T with the cycle time of the used cyclic interrupt
is necessary.

Configure the inputs COMMAND_ID, DATA_ID, COMMAND_PORT, DATA_PORT and
CURRENT_CHANNELS of the ION_PN. Configure the inputs UIKO..UIK7 in CFC.

Finally the CPU must once be restarted (STOP, >RUN) thereby that ION SIMATIC S7 PN is
initialized and a connection to X-Tools can be established.

£ CFC - [CFC -- SIPLUS\SIMATIC 57 PN\,CPU 57 PN\...]
[# Plan Beatbeiten Einfiigen Zielsystem Test Ansicht Extras Fenster Hilfe _|ﬁl|5|

Ol18) 1|3 85 517 74 o] 3ol =) 2] BT =1 2/ B el
2| alsle| =] Pl

-l Neuer Plan H [ |

----- Meuer Text . |
[]---@ Alle Bausteine | | i )
-y BIT_LGC 1 1/1
- COMPARE |
-y COMVERT . 0—| PRESSURE
(- FLIPFLOP . 0—| PRESSURE
3 Jaind | o
- @ MULTIPLY | NIMBERZ
-4y SHIFT CNT
G-y WRD_LGC | | DWORDE
[]---Q Sonstige Bausteine DWORD?

El-{Z8 57-Programm | DWORDS
£ BLKMOW [SFC20: Copy Yariables] DUORDS
g‘ DT_TOD [FCE: DT bo TOD] DUORDLO
p IOM SIMATIC 57 PN [FB3: ION SIMATIC 57 PM] u DUOEDLL
g IOM_PM [FBEOO: PCS 7 block FOR ION SIMATIC 57 PM] T
£ RD_SINFO [SFC6: Read OB Start Information] =
47 READ_CLK [SFC1: Read System Clack] DWORD13
£ TCON [FESS: Connect] || DWORD1 4
4 TURCY [FBES: Receive Data via UDP] DWORD1S
&7k TUSEND [FEE7: Send Data wia LIDP] . REALD
i REALL
|| REALZ
REALSZ
| EEAL4
REALS b
REALG
N REAL7
REALS
N REALS
|| REALLO
COM R3T
| COMMAND
DATA ID
| COMIAND
Ciiy ine |E1pEne |l Ebiceren | W WY

DEVW _ID

CUREENT
TIED

[~ Anfangsbuchstaben suchen

.22
Y |

AT/

Driicken Sie F1, um Hilfe 2u erhalten. [~ |&/Blatt 1 |C¥C_INTE CFC CFCM

Call of the adapted CFC BLOCK S7 PN of covering component in the CFC

| R4 KN
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8.1

8.2

8.3

8.4

8.5

Tips and Tricks

Reset the Function Block

The ION SIMATIC S7 PN can be reset by COM_RST. This input can be connected to a bit
memory which makes it possible to reset the ION SIMATIC S7 PN at any moment easily.

Engineering during Runtime

Because of the possibility to initialize the ION SIMATIC S7 PN via input COM_RST you can
add it to you project during runtime. It is no STOP - RUN of the CPU necessary.

Changing the Number of the Function Block

The number of ION SIMATIC S7 PN (FB3) can be changed user-defined. It is just necessary
to adapt the Symbol Table. It is possible to change the numbers of FB65/FB67/FB68 by
STEP 7 option “Rewire”. When you plan to rewire the blocks it is recommended to do this in
an empty project and add just the rewired blocks into you working project.

Analyzing of Connection-Problems

If the interface is not able to transmit all data (OB-cycle to fast or communication too high)
the variable “Dummy1” in the corresponding DB is rising. This can be supervised by variable
table or it can be transmitted to X-Tools via the ION SIMATIC S7 PN.

Multi-Instancing of ION SIMATIC S7 PN

It is possible to call multiple instances of the ION SIMATIC S7 PN in one SIMATIC CPU. This
is necessary when the required amount of data is more than 712 Byte per cycle.

Each instance of the ION SIMATIC S7 PN must be called in OB100 with COM_RST = TRUE
to initialize the FB. For each instance a separate data block and a dedicated connection pair
(command and data connection) is required. The connections are identified by
COMMAND_ID, DATA_ID, COMMAND_PORT und DATA_PORT. The parameters
COMMAND_ID and DATA_ID can be taken from 0x0001 to OxOFFF. Each ID must be used
for one connection only.

The UIK must be unique for each ION SIMATIC S7 PN. The bytes UIK2...UIK7 shall be set to
the MAC address of the used PROFINET interface. To keep unique UIKs for each ION
SIMATIC S7 PN in the bytes UIKO and UIK1 can be numbered sequential.

The number of usable instances is limited by capacity of CPU. If multiple instances are called
in one controller the memory usage and cycle time of the CPU have to be checked.

Each active ION SIMATIC S7 PN needs a software license key.
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9 Appendix

9.1 Other Documentation

Manual: SIPLUS CMS4000 X-Tools User Manual

Reference Manual: SIMATIC System Software for S7-300/400 Systen and Standard
Functions

Manual: SIMATIC Programming with STEP 7

http://www.siemens.com/siplus-cms

9.2 Service & Support in the Internet

In addition to our documentation pool we offer our complete knowledge base on the Internet:

www.siemens.com/automation/service&support

There you find:

The newsletter, which is constantly updated to provide you with the latest information
about your products.

The right documents via our search function under Service & Support.
The bulletin board, a worldwide knowledge exchange for users and experts.

Your local representative for Industry Automation & Drives Technologies via our
representatives database.

Information about on-site services, repairs, spare parts, and lots more you will find under
"Support”.

9.3 Contact Information

Address

Siemens AG

I 1A CE DE

Wuerzburger Strasse 121
90766 Fuerth

Germany

Internet

http://www.siemens.com/siplus-cms
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9.4 Terms

The following terms are used within this document:
Definition |Description

CP Communication Processor

DB Data Block

FB Function Block

ION I/O-Node

OB Organization Block

UIK Universal Identification Key

SW Software
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